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Important
Information

Before you install and use your SMART Board™ V280 interactive whiteboard,
read and understand the safety warnings and precautions in this user’s guide and
the included warnings document. These safety warnings and precautions describe
the safe and correct operation of your SMART Board interactive whiteboard and
its accessories, helping you to prevent injuries and equipment damage.

[ NOTE
In this document, the term “interactive whiteboard” refers to your interactive
whiteboard and its accessories and options.

'y WARNINGS
« Failure to follow the installation instructions included with your interactive
whiteboard, or found in this guide, could result in personal injury or
product damage.

* Read the safety warnings, precautions and other important information
published by your projector’s manufacturer. Do not stare (or allow children
to stare) directly into your projector’s beam of light. Do not touch (or allow
children to touch) your projector because it can become extremely hot during
normal operation.

+ Two people are required to safely mount your interactive whiteboard on a wall
or floor stand because it might be too large for one person to safely maneuver
alone. When you lift your interactive whiteboard, you and your assistant
should stand on either side of the screen, supporting its weight at the bottom
corners while balancing the top with your other hands.

* Do not leave cables on the floor where they can be a tripping hazard. If you
must run a cable over the floor, lay it in a flat, straight line and secure it to the
floor with tape or a cable management strip of a contrasting color. Handle
cables carefully and avoid excessive bending.
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* Do not mount your SMART Board V280 interactive whiteboard on an FS670
or FS570 floor stand. These floor stands do not provide the correct locking
mechanisms to properly secure your interactive whiteboard. Using these
stands could result in personal injury and product damage.

*  Move your floor stand-mounted SMART Board interactive whiteboard
with care. Quick stops, excessive force and uneven surfaces might cause
your product to overturn.

* Do not stand (or allow children to stand) on a chair to touch the surface
of your SMART product. Instead, remount your product at the appropriate
height, or use an FSV280 height-adjustable floor stand.

* Do not climb (or allow children to climb) on your wall- or
stand-mounted SMART Board interactive whiteboard.
Climbing on your interactive whiteboard or projector boom

could result in personal injury or product damage. -

/
CAUTIONS
* Avoid exposing your SMART product to extreme heat or cold. SMART Board
V280 interactive whiteboards can operate in the temperature range of
41°F to 95°F (5°C to 35°C) with up to 80% humidity (non-condensing).
The shipping and storage temperature range is from -40°F to 120°F
(-40°C to 50°C).

* Do not lean your interactive whiteboard against a wall. Your interactive
whiteboard’s frame and pen tray brackets are not designed to continuously
sustain the product’s weight. Make sure that you carefully place it face down
on a clean, flat surface instead.

» To ensure a safe installation and to prevent your interactive whiteboard
from being accidentally knocked off the wall, make sure that you secure your
interactive whiteboard to the wall with the included wall anchors and screws.

* Use only the screws included with your SMART Board V280 interactive
whiteboard. Using other screws might damage your product.

* Do not let the top of your interactive whiteboard contact the wall because the
caps covering the interactive whiteboard’s DViT™ (Digital Vision Touch)
cameras could be damaged.

* Do not add any extra weight or excessive pressure to your wall-mounted
interactive whiteboard or its pen tray. SMART designed the wall mounting
bracket to support only the weight of your interactive whiteboard during
normal use.
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For operating safety and to avoid damage to your SMART Board interactive
whiteboard, use only the included high-speed USB 2.0 cable that came with
your interactive whiteboard to connect it to a computer that has a high-speed
USB 2.0 compliant port and that bears the USB logo. In addition, the USB
source computer must be compliant with CSA/UL/EN 60950 and bear the
CE mark and CSA and/or UL Mark(s) for CAS/UL 60950.

Your computer requires the processing power specified in the SMART Board
V280 Interactive Whiteboard Specifications (document 121618 at
www.smarttech.com/support) when you use your SMART Board V280
interactive whiteboard with a standard projector. If you add accessories to
your computer, including but not limited to an AirLiner™ wireless slate,
SMART Response interactive response system or a SMART Document
Camera, you must increase the processing power of your computer
substantially. SMART will not be held responsible or liable for any damage
caused or loss suffered as a result of insufficient processing power.

Your SMART Board V280 interactive whiteboard is not a dry-erase product.
Do not use dry-erase or permanent markers on its surface.

Do not use harsh chemicals or abrasive cleaners on your interactive
whiteboard.

If you own a SMART product other than a SMART Board V280 interactive whiteboard,
refer to the installation manual for your product for relevant warnings and
maintenance instructions.

To ensure operating safety and to avoid product damage, observe the following
precautions.

Don’t set up and use your interactive whiteboard in an area with excessive levels
of dust, humidity or smoke.

Before installing your SMART Board V280 interactive whiteboard, ensure
that the USB cable connections are secure.

Laptop computers operating in power save battery mode might not provide
sufficient power to run your interactive whiteboard reliably. Plug your laptop
computer into an AC power receptacle to run your interactive whiteboard.

Be aware that connecting a webcam to your computer might prevent
your SMART Board V280 interactive whiteboard from operating reliably.


http://www2.smarttech.com/kbdoc/121618
www.smarttech.com/support
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Connect an external power supply (not included) to your SMART Board V280
interactive whiteboard when using a bus powered hub, such as the SMART Active
USB Extension Cable, with your product. The external power supply

(when required) must meet the Limited Power Source (LPS) requirements

of CSA/UL/IEC/EN 60950-1.

Before your clean your interactive whiteboard, shut down or disconnect
the connected computer.

If your SMART Board interactive whiteboard requires replacement parts,
make sure that the service technician uses replacement parts specified by
SMART Technologies.

Be aware that Kensington® locks aren't designed to be a solid protection measure
because the lock can be torn out. However, potential thieves might be reluctant
to try to sell a product with a broken Kensington lock hole, which would readily
identify it as a stolen item.
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Chapter 1

Introducing Your
SMART Board V280
Interactive
Whiteboard

In This Chapter

Refer to these topics to learn more about your SMART Board V280 interactive
whiteboard and its parts and accessories.

1] (g o (U1 i o] o RSSO 2
FRAIUIES ... 2
How Does Your SMART Board Interactive Whiteboard Work? ...................... 3
Minimum Computer REqQUIremMENtS ...........coooiiiiiiiiiiiiiiiiieeeeeeee e 4
Contents of Your SMART Board Interactive Whiteboard Shipping Box ......... 4
Standard Replaceable Parts..............coooooiiiiiiiiiee e, 7

Other ACCESSOIIES ... oottt e e et e e e e e e e e e e aaaeeaeaas 7
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Your SMART product is a wall-mounted, pen-only front projection interactive
whiteboard. It enables you to do everything that you can do at your computer—
open and close applications, scroll through files, conference with others, create
new documents or edit existing ones, visit websites, play video clips and more—
by touching the screen with the included pen. When you connect your interactive
whiteboard to a computer and a projector, your computer image displays on the
screen. You can write over any application in digital ink, and then save these notes
to a SMART Notebook file for future reference and distribution.

Your SMART Board V280 interactive whiteboard is a high-speed USB 2.0 bus
powered device, with no external power supply. Since USB is the primary connectivity
mode, your interactive whiteboard receives power from the computer via the included
16' (5 m) high-speed USB 2.0 cable. There’s no power switch on your interactive
whiteboard. It's always running when your computer is turned on.

Your SMART Board V280 interactive whiteboard
is durable and reliable. It features a rugged,
hardened writing surface, a damage-resistant pen
and SMART’s proprietary DVIT (Digital Vision
Touch) technology. Your interactive whiteboard
measures 77" diagonally and has a 4:3 aspect
ratio. A pen tray spans the width of the product.

Feature Highlights -

DViT Technology
Two digital cameras located in each corner of the upper valance track the position
of the reflective tip of the pen as it moves across the display surface.

Pens

Each interactive whiteboard pen provides an intuitive tip switch interface for power
management. These battery-operated pens function equally well for adults and
children of all ages, and are designed to withstand the rigors of daily use.

Durable Surface
The hard laminate surface is puncture resistant and optimized for projection.

Kensington Lock Feature
This security feature enables you to lock your interactive whiteboard with a security
cable to help safeguard it from theft.
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How Does Your SMART Board Interactive
Whiteboard Work?

Your SMART Board interactive whiteboard and pen function as input devices
for your computer, just like a mouse, enabling you to work in any application available
on your connected computer from your interactive whiteboard’s screen.

When you connect your interactive whiteboard to a computer running SMART product
drivers, the following actions occur:

*  The computer runs an
application, and then sends
the image to your projector.

*  Your projector casts the image
onto your interactive whiteboard.

*  Your interactive whiteboard acts
both as your computer’s monitor
and its input devices, i.e., mouse
and keyboard, enabling you
to control any application
by touching the screen with
your pen.

When you install SMART Notebook software on your computer, a Floating Tools
toolbar floats over your desktop and any open application. By default, SMART
Notebook interprets your pen presses as left mouse clicks. When you select a pen
button on the Floating Tools toolbar, SMART Notebook interacts with the computer's
mouse driver to change the pointer into a colored pen, which enables you to write over
your desktop or any open application with digital ink. You can change pen settings,
including the transparency, color or width of the ink. You can then save your notes

to a SMART Notebook file, or directly into any Ink Aware application. You can also
select and customize other tools, such as the width of the eraser tool you use to erase
your notes.



4 | INTRODUCING YOUR SMART BOARD V280 INTERACTIVE WHITEBOARD

Minimum Computer Requirements

To successfully power your interactive whiteboard and run SMART product drivers,
your computer must meet certain minimum operating specifications. For your
interactive whiteboard’s system requirements, see the SMART Board V280 Interactive
Whiteboard Specifications (document 121618 at www.smarttech.com/support).

Y CAUTION
Your computer requires the processing power specified in document 121618
at www.smarttech.com/support when you use your SMART Board V280
interactive whiteboard with a standard projector. If you add accessories
to your computer, including but not limited to an AirLiner wireless slate, SMART
Response interactive response system or a SMART Document Camera, you must
increase the processing power of your computer substantially. SMART will not be
held responsible or liable for any damage caused or loss suffered as a result of
insufficient processing power.

Contents of Your SMART Board
Interactive Whiteboard Shipping Box

You'll find the following parts in your interactive whiteboard shipping box:

« a SMART Board V280 interactive , 0
whiteboard 1 v v v t

« an interactive whiteboard valance



http://www2.smarttech.com/kbdoc/121618
www.smarttech.com/support
http://www2.smarttech.com/kbdoc/121618
www.smarttech.com/support
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three L-shaped tabs

a 32" (81.3 cm) wall-mounting bracket

eight self-tapping wall anchors

eight long self-tapping screws

three small thread-forming screws

a 16' (5 m) high-speed USB 2.0 cable

two battery-operated pens

&

g«
g
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two AAA alkaline batteries

two software CDs

four replacement pen nibs

four replacement pen tips

a limited warranty document

e ——
LT —

a product registration card

textless installation instructions
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Standard Replaceable Parts

Contact your authorized SMART reseller to purchase any of the following items.

SMART High-Speed USB 2.0 Cable

An included 16' (5 m) high-speed USB 2.0 cable provides power to your
SMART Board interactive whiteboard from your Windows® computer.

Pens
Two LEDs embedded in the tip of each battery-powered pen enable your interactive
whiteboard’s cameras to track the pen tip as it moves across the screen surface.

SMART Board Interactive Whiteboard Wall-Mounting Kit

A 32" (81.3 cm) wall-mounting bracket comes with five screws and drywall anchors,
enabling you to wall-mount your interactive whiteboard simply and securely.

Pen Nibs and Tips

Your interactive whiteboard comes with four replacement pen nibs and tips.

[ NOTE
You can also replace the detachable valance and the USB hub. Additionally, you
can replace your interactive whiteboard’s cameras without special tools. Contact
your authorized SMART reseller to order these field replaceable units.

Other Accessories

Contact your authorized SMART reseller to order any of the following accessory parts.

Floor Stand

You can also mount your SMART Board V280 interactive whiteboard on a
height-adjustable floor stand. To learn more about the FSV280 floor stand,
see Appendix C on page 67.

USB Extender Cables

If you wish to extend the length of the included 16' (5 m) USB cable between your
interactive whiteboard and your computer, the SMART Active USB Extension Cable
can increase this distance by an extra 16' (5 m) to a maximum of 32' (10 m).

See Appendix B on page 65 for more information.


http://www2.smarttech.com/st/en-US/Where+to+Buy/
http://www2.smarttech.com/st/en-US/Where+to+Buy/
http://www2.smarttech.com/st/en-US/Where+to+Buy/
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Chapter 2

Installing and
Securing Your

SMART Board V280
Interactive Whiteboard

In This Chapter

Refer to these topics for information about wall-mounting your SMART Board V280
interactive whiteboard.

Environmental Requirements ... 10
Installing Your SMART Board V280 Interactive Whiteboard ........................ 11
Before Installing Your Interactive Whiteboard...........ccccccoovvviiiiiiiininnis 11
Recommended Heights for Wall-Mounting............cccccevevniiiiiee i 11
TOOIS REQUITEA .....ciiiiiiiiii e 12
Wall-Mounting Your Interactive Whiteboard............ccccccccoiiiiiiiiiinnnen. 12

Aligning Your Interactive Whiteboard with Your Projector (Optional)..... 15
Completing Your Installation ...........cccoccuiiiiiiiiiiie e 15
Preparing the PenSs ..........uiiiiii e 18

Securing Your Interactive Whiteboard with a Kensington Lock.................... 19
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Before installing your SMART Board V280 interactive whiteboard, review the following
environmental requirements.

Environmental

Parameter
Requirement

Operating temperature 41°F to 95°F (5°C to 35°C)

Storage temperature  -40°F to 120°F (-40°C to 50°C)

Humidity 5-80% relative humidity, non-condensing

Water and fluid * Intended for indoor use

resistance + Don't pour or spray liquids directly on the electronic
components

* Moderate dust

» Designed for pollution degree 1 (P1) as per EN61558-1,
which is defined as “No pollution or only dry
non-conductive pollution.” Refer to page 45 for detailed
instructions on periodically cleaning your interactive
whiteboard.

Dust

Electrostaticdischarge + Designed to withstand electrostatic shock
(ESD) - EN61000-4-2 severity level 4 for direct and indirect ESD

» No malfunction or damage up to 15kV (both polarities)
with a 330 ohm, 150 pF probe (air discharge)

+ Unmated connectors meet no malfunction or damage
up to 8kV for direct (contact) discharge

Conducted and EN55022/CISPR 22, Class B
radiated emissions

Flammability rating + Electronics and connectors: UL 94-VO
» USB enclosure (hub plastics): UL94-HB
+ USB 2.0 cable: UL VW-1/CSA FT4

Quality assembly * USB cable: IPC/WHMA-A-620 Class 2 workmanship
standards for Requirements & Acceptance for Cable &
Wire Harness

+ Digital cameras: IPC-A-610 standards for Acceptability
of Electronic Assemblies, to Class 2 specifications
(Dedicated Service Electronic Parts)
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Before Installing Your Interactive Whiteboard

Before you install your SMART Board V280 interactive whiteboard, choose a location
that’s protected from direct sunlight. Bright light sources, such as a window

with exposure to direct sunlight, can reduce the contrast of the projected image

and might affect the performance of your interactive whiteboard’s infrared technology.

Also consider where you installed, or plan to install or position, your projector. Position
your projector and interactive whiteboard at the correct height and distance apart

so that the projected image aligns with the display screen. Remember to leave
enough room on either side of your interactive whiteboard for you to stand beside it.

[ NOTE
You can also mount your SMART Board V280 interactive whiteboard
on a floor stand. For more information, see Appendix C on page 67.

Recommended Heights for Wall-Mounting

Consider the general height of your user community when you choose a height for
your wall-mounted interactive whiteboard. If your interactive whiteboard is too low, it
might force some people to bend over uncomfortably. If it's too high, other people
might need to reach up too far. For adults of average height, position your interactive
whiteboard’s wall-mounting bracket 78 5/8" (2 m) above the floor. The distance to the
top of your interactive whiteboard will be 84" (213.4 cm).

For children, shorter adults and adults in wheelchairs, position your interactive
whiteboard’s wall-mounting bracket 60 3/4" (154.3 cm) above the floor. The distance
to the top of your interactive whiteboard will be 66" (167.7 cm).

Yy WARNING
Two people are required to safely mount your SMART Board V280 interactive
whiteboard on a wall or a floor stand because it might be too large for one person
to safely maneuver alone. When you lift your interactive whiteboard, you and your
assistant should stand on either side of the screen, supporting its weight at the
bottom corners while balancing the top with your other hands.

@ NOTE
When you mount your interactive whiteboard lower on the wall, keep it high
enough that furniture or other objects won’t obstruct the projected image.
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Tools Required
To wall-mount your interactive whiteboard you’ll need the following tools,
which aren’t included with your package:

* a Phillips® No. 2 screwdriver

[ NOTE
All screws must be tightened by hand.

* aruler or tape measure
* acarpenter’s level

* apencil or other marking device

* astepladder

Wall-Mounting Your Interactive Whiteboard

Follow this procedure to mount your SMART Board V280 interactive whiteboard
on a framed wall surfaced with gypsum or drywall. Some notes are provided

for concrete wall installations.

Yy WARNING
Failure to follow these instructions might result in personal injury and
product damage.

[y CAUTIONS
+ Do not lean your interactive whiteboard against a wall. Your interactive
whiteboard’s frame and pen tray brackets are not designed to continuously
sustain the product’'s weight. Make sure that you carefully place it face down
on a clean, flat surface instead.

* Use only the screws included with your SMART Board V280 interactive
whiteboard. Using other screws might damage your product.

IMPORTANT
After you lay your interactive whiteboard on a clean, flat surface, ensure that
the camera USB cable connections are secure.

[ NOTE
To take full advantage of all the interactive features of your SMART product, you
must connect a digital projector (not included).
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To mount your 1. Place your interactive whiteboard face down on
interactive whiteboard a clean, flat surface, and then slide an included

L-shaped tab into the slot in each of the three ‘

pen tray brackets.
i®

=
E———

o mp -

2. Ensure that the two USB cables extending from each camera to the USB hub
are securely connected, and that the cable clip is fastened, as illustrated below.

3. Using a pencil, a carpenter’s level and a
measuring tape or ruler, draw a horizontal line
on the wall, centered on the mid-point of your
interactive whiteboard'’s future position. If your
projector is already mounted on the ceiling, this
is roughly the center of your projected image.

[ NOTE
The illustration on the right shows a
common height for adult users
of SMART Board V280 interactive

whiteboards. Refer to page 11 for the
recommended mounting height for other users.
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4. Using the mounting bracket as a template,
mark the location of the five mounting holes
on the wall.

5. Use the Phillips No. 2 screwdriver to secure an included self-tapping wall anchor
at each mark.

[ NOTE

Don’t use a hammer to tap these anchors
into the wall. If you find it impossible to
screw an anchor flush with the wall, you
might have encountered a stud. If this is the
case, you don’t need to use an anchor in
this location. The stud will provide
adequate support for the screw that
secures the bracket to the wall.

n NOTES
— For a concrete wall, drill holes at the

marks, and insert concrete anchors (not included) into the holes.

— If necessary, stand on a stepladder so that you're able to secure
the wall anchors flush with the wall.

6. Using the screwdriver, secure the wall-mounting bracket to the self-tapping wall
anchors with five of the included long self-tapping screws.

7. With the help of another person, hang your interactive whiteboard on the center
of its wall-mounting bracket.




To align your
interactive whiteboard
with your projector

To complete your
installation
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Aligning Your Interactive Whiteboard with Your Projector
(Optional)

If your projector is installed in a fixed location, align your interactive whiteboard
to the projected image before you secure the L-shaped tabs.

1. Install or position your projector on a projector
platform or stand if necessary, and then turn it
on and point the lens of your projector at the
center of your interactive whiteboard’s screen.

2. Make fine adjustments to the image size, level
and focus of the projected image, according
to your projector manufacturer’s instructions.

3. Slide your interactive whiteboard sideways on
its bracket to align it with the projected image.

4. Repeat steps 2 and 3 until your interactive
whiteboard is properly aligned.

A correctly aligned image fits squarely on your interactive whiteboard’s screen. Each
side of the projected image should extend almost to the edge of the display surface.

Completing Your Installation
Refer to the following procedure to finish installing your interactive whiteboard.

1. Push your interactive whiteboard securely .
against the wall, and then slide each L-shaped v
tab backward until it contacts the wall. R

LT T NK

«3,(

Each of these tabs has an adjustment
range of 1/2" (1.5 cm) to accommodate
uneven wall surfaces.

[ NOTE N
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as illustrated. s LI

s

1

2. Using the screwdriver, secure each of the i
three tabs to its corresponding bracket with one [ ... %
of the included small thread-forming screws, A —
3x

3. Using each tab as a template, mark the location
of the three holes on the wall.

4. Slide your interactive whiteboard 2" (5 cm) sideways to the left along the
wall-mounting bracket.

5. Using the screwdriver, secure an included self-tapping wall anchor at each mark.

n NOTE
For a concrete wall, drill holes at the marks, and then insert concrete anchors
(not included) into the holes.

2" (5¢cm)

6. Slide your interactive whiteboard 2" (5 cm) back to the right along the
wall-mounting bracket.
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7. Using the screwdriver, secure an included long metal self-tapping screw through
each of the three tabs and into the wall anchors beneath.

O]

7Y CAUTION
To ensure a safe installation and to prevent your interactive whiteboard from
being accidentally knocked off the wall, make sure that you secure your
interactive whiteboard to the wall with the included wall anchors and screws.

[ NOTE
If you want to lock your interactive whiteboard with a security cable, see
Securing Your Interactive Whiteboard with a Kensington Lock on page 19.

8. Hook the valance over the clips (at the top
of your interactive whiteboard) until the valance
snaps in place.

[ NOTE
If you try to lift your interactive whiteboard
by the valance, it will detach.
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Preparing the Pens
Refer to the following procedure to prepare the included interactive whiteboard pens
for use.

1. Pull back the battery cover of each pen to open
the battery compartment, and then insert
an AAA battery, as illustrated.

2. Press the tip switch on the nib of each pen
with your finger to check that the pen is working
properly. The LED light beside each battery
compartment illuminates green. Place the pens v E\”/
on the pen tray. w B

) NOTES ‘
— Agreen LED light indicates that the
pen is operating properly. A red LED
light indicates that less than one hour
of battery operating time remains.

— Ifthe pen’s LED light doesn’t illuminate when you press the tip switch
on the nib, see page 60.

After you install your interactive whiteboard, connect your digital projector to your
computer by following the manufacturer’s instructions included with your projector.
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Secure your interactive whiteboard by attaching a security cable, such as a
Kensington cable and lock device (not included), to your interactive whiteboard
and an immovable object.

IMPORTANT
Kensington locks are not designed to be a solid protection measure because
the lock can be torn out. However, potential thieves might be reluctant to try
to sell a product with a broken Kensington lock hole, which would readily identify it
as a stolen item.

In each of the three brackets under your interactive whiteboard’s pen tray, you'll find
a lock slot that accommodates a security cable.

Lock Slot Locations
(Viewed from the Rear)

To secure your 1. Loop the security cable around a heavy or immovable object, and then thread
interactive whiteboard the lock end of the cable through the loop end of the cable.

2. Insert the prong end of the lock into the lock slot, following the instructions
that came with your cable.

[ NOTE
You might not be able to access the lock slots in the outside brackets
from the side that is closest to the outside edge of your interactive whiteboard.
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Connecting
Your Interactive

Whiteboard
to a Computer

In This Chapter

Refer to these topics for information about connecting your SMART Board V280
interactive whiteboard to a computer.
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Your SMART Board V280 interactive whiteboard’s high-speed USB 2.0 interface
enables you to connect your interactive whiteboard to your computer. Because the
included USB 2.0 cable provides both a digital signal and power from your computer
to your interactive whiteboard, you don’t require an additional power supply.

Y CAUTION
»  For operating safety and to avoid damage to your SMART Board interactive
whiteboard, use only the included high-speed USB 2.0 cable that came with
your interactive whiteboard to connect it to a computer that has a high-speed
USB 2.0 compliant port and that bears the USB logo. In addition, the USB
source computer must be compliant with CSA/UL/EN 60950 and bear the
CE mark and CSA and/or UL Mark(s) for CAS/UL 60950.

» Use only the included high-speed USB 2.0 cable to connect your
SMART Board V280 interactive whiteboard to your computer.

IMPORTANT
Laptop computers operating in battery mode might not provide sufficient power to
run your interactive whiteboard reliably. If you're using your interactive whiteboard
with a laptop computer, connect your laptop computer to an AC receptacle.

Your SMART Board V280 interactive whiteboard
has a high-power USB 2.0 high-speed peripheral
interface that runs at speeds of up to 480 Mbps.
The unit works with USB 2.0 compliant
interfaces only.

Your interactive whiteboard’s main USB connection
is a captive flying lead cable. The connector is a
USB Type-B receptacle. This captive cable

provides convenient access to the USB receptacle Captive USB Cable

without you having to remove your interactive
whiteboard from the wall.



23 | CONNECTING YOUR INTERACTIVE WHITEBOARD TO A COMPUTER

To connect using the 1. Connect one end of the included 16' (5 m) USB
included USB cable cable to the captive connector suspended from
your interactive whiteboard’s lower-right corner.

[ NOTE : E

Use only the included high-speed USB 2.0 =T
cable to connect your SMART Board V280 1. B
interactive whiteboard to your computer. i :

2. Connect the other end to a high-speed USB 2.0
receptacle on your computer.

[ NOTES
— USB receptacles on the front of your computer might not provide enough
power for your interactive whiteboard.

— You need a powered, high-speed USB 2.0 extender cable to exceed
16' (5 m). See Appendix B on page 65 for more information.

IMPORTANT
Laptop computers operating in battery mode might not provide sufficient
power to run your interactive whiteboard reliably. Connect your laptop
computer to an AC power receptacle to run your interactive whiteboard.

3. Press the power button on your computer to start your interactive whiteboard.
4. If necessary, press the power button on your projector to start it.

Your interactive whiteboard’s controller is now receiving power from your
computer and you should see the projected computer image on your screen.

[ NOTE
You might find it easier to see your SMART Board interactive whiteboard’s
screen if you turn off lights in the room, or close the blinds. Direct sunlight
might also affect the performance of your interactive whiteboard.

5. Log on to your computer if required. If your computer doesn’t require you to log
on, allow your computer to reach its default start screen.

You should now configure your computer settings, and then install SMART product
drivers (page 25).
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For optimal configuration, use the following recommended settings for the computer
supporting your interactive whiteboard.

Recommended Settings

Configure your computer’s power management settings to turn off the monitor after
one hour of inactivity and to put the hard disks into standby mode after two hours. This
extended period prevents the computer from shutting down unexpectedly

(for example, during presentations or meetings that have gaps in computer activity).

Your computer will stop sending an RGB video signal to your projector after a period
of idle time, which also triggers the projector to go into standby mode. Similarly, you
can put your projector in standby mode by following the manufacturer’s instructions

included with your projector.

To change the settings in the Windows operating system, double-click the

Power Options icon in the Windows Control Panel, and then adjust the energy saving
features and power management properties in the Power Schemes tab. For more
information on changing these power management settings, see the instructions
included with your operating system.

Matching Your Computer’s Resolution to Your

Projector’s Resolution

Ensure that the resolution settings for your projector and computer match. If your
computer’s resolution doesn’t match the projector’s resolution, the image won’t
properly fill your interactive whiteboard’s screen and might shimmer or be distorted.

Set the projector to its optimal image resolution by following the instructions included
with your projector, and then set your computer’s resolution to match. You can change
your computer’s screen resolution in the Windows Control Panel. If you need further
help changing your computer’s resolution, see the instructions included with your
operating system.

You might need to adjust your computer’s refresh rate to obtain the best results. Set
the computer to an initial refresh rate of 60 Hz, and then adjust this rate up or down
until you've determined the ideal refresh rate. For more information on changing your
computer’s refresh rate, see the instructions included with your operating system.
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After you install SMART product drivers on your computer, your SMART Board V280
interactive whiteboard’s display will respond to the touch of an interactive whiteboard
pen on its screen surface. SMART product drivers include the tools that you need

to control computer applications with the included pen, and to write over them in
digital ink.

You can install SMART product drivers on any computer that meets certain minimum
operating specifications using the software CD included with your SMART product.
For your interactive whiteboard’s system requirements, see document 121618

at www.smarttech.com/support.

IMPORTANT
Before installing SMART product drivers from the included CD:

« Connect your interactive whiteboard to your computer with the included
USB cable, as described on page 23. If you connect your interactive
whiteboard to your computer after you install SMART product drivers, you
might see an error message stating that SMART Board Service encountered
a problem. For more details, see http://www2.smarttech.com/kbdoc/133790.

* Remove all versions of SMART software or SMART product drivers
previously installed on your computer, and then restart your computer.
If you do not know how to remove software, ask your system administrator.

1. If necessary, turn on your computer and projector, and close all open applications
on your computer.

2. Insert the included SMART product drivers CD in your computer’s CD drive to
launch the software installation screen, and then follow the on-screen instructions.

SMART Board Tools open automatically.

3. If SMART Board Tools don’t open, select Start > All Programs >
SMART Technologies > SMART Board drivers > SMART Board Tools.

The SMART Board icon [-] appears in the notification area and your interactive
whiteboard communicates successfully with SMART product drivers.

After you install SMART product drivers, you should perform a brief orientation
procedure, as described in the following section.


http://www2.smarttech.com/kbdoc/121618
http://www2.smarttech.com/st/en-us/support
http://www2.smarttech.com/kbdoc/133790
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Your SMART Board V280 interactive whiteboard includes default orientation data
from the manufacturing process. After you install SMART product drivers on your
computer, orient your interactive whiteboard. Orienting your interactive whiteboard
ensures the greatest possible level of writing and touch accuracy. Orient your
interactive whiteboard any time your projector or interactive whiteboard has moved
since you last used it, or whenever the mouse pointer isn’t properly aligned with the
pen when you touch the screen.

When you orient your interactive whiteboard, ensure that it is away from ambient
lighting caused by sunlight or incandescent pot lights. Fluorescent lighting has no
effect on your interactive whiteboard’s orientation. Ensure that your projector,
computer and SMART product drivers are running.

To orient your 1. At your computer, click the SMART Board icon [-] in the notification area,
interactive whiteboard and then select Orient.

The Orientation screen opens.
2. Pick up a pen from the pen tray.

3. Beginning at the upper-left corner of the screen, touch the center of the target
firmly with the tip of the pen until the target moves to the next point. Try not to flick
the pen when you lift it from the screen, and make sure that the direction of the lift
is at a right angle to the screen.

<4

Press center of target and hold until the target moves.

Full Orientation Screen



To change the
orientation precision

27 | CONNECTING YOUR INTERACTIVE WHITEBOARD TO A COMPUTER

[ NOTE
When you press the nib of the pen against your interactive whiteboard’s
screen, the LED light on the pen illuminates.

¥ 7

Good Orientation Point Poor Orientation Point
The pen touches the center of the target.

4. Repeat step 3 until you arrive at the last point.

[ NOTE
If you're not satisfied with the precision of a particular point, press the left
arrow key on your computer’s keyboard to repeat the orientation for that point.

5. At the last point, touch the center of the target firmly and continue pressing
until the message “Please wait while Orientation completes” appears.

The Orientation screen closes.

The orientation procedure can be six or fifteen touches, depending on the precision
setting you specify in your SMART Hardware Settings in the SMART Notebook control
panel. The following procedure shows you how to change the precision setting.

1. Select the SMART Board icon [-J once in the Windows notification area, and then
select Control Panel.

Select SMART Hardware Settings.
Select Orientation/Alignment Settings from the drop-down list.

Select the desired setting, and then press OK.

o > 0w BN

Perform an orientation procedure so that the precision change takes effect.
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Your interactive whiteboard includes two battery-powered pens. After SMART product
drivers are running on your connected computer, use these pens to write in digital ink
on your desktop image or any open application. If necessary, move the mouse or
touch any key on your keyboard to bring your computer out of standby mode.

When you touch your interactive whiteboard’s writing surface with the pen, infrared
digital cameras located in the upper corners of your interactive whiteboard’s frame
detect light reflected from the pen’s tip above the writing surface, and register the tip’s
horizontal and vertical (or x and y) coordinates on the display surface. Your
computer’s mouse driver interprets these coordinates and moves the pointer

to the corresponding point on the projected image.

To open an application on your interactive whiteboard, press the tip of the pen twice
consecutively on the application’s icon. When you double-press the pen to open an
application, it is the same as double-clicking your mouse to open an application on
your computer. Similarly, each time you single-press on your interactive whiteboard’s
screen with the pen, it is the same as a single left mouse click.

As you press the pen on your interactive whiteboard, the LED indicator light in front of
the battery compartment should illuminate green. If this light is red, the pen’s battery
charge is low and you should replace the battery. If the applications that you're using
don’t respond to the touch of the pen, check that the indicator light is illuminated. If it
doesn’t illuminate, apply more pressure. If it still doesn’t illuminate, the pen’s battery
has no charge or isn’t installed. In either case, you should install a fresh battery.

See see document 129600 at www.smarttech.com/support for more information on
troubleshooting your SMART Board V280 interactive whiteboard’s pen.



http://www2.smarttech.com/kbdoc/129600
http://www2.smarttech.com/st/en-us/support
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Instant Conferencing Using SMART Bridgit Software ............ccccceeeneee. 39
Other SMART TOOIS ....ccciiiiiiiiie e 39
Writing and Drawing Directly into Software Applications............ccccoevveeennn. 40
Where to Find More Information ............coooiiiiiii e 41

SMART Notebook software enables you to capture and save your notes to a SMART
Notebook file, or to write directly into any Ink Aware application. The full capabilities of
SMART Notebook include SMART Board Tools and a wide range of digital content.

IMPORTANT

»  Before you install SMART Notebook software from the included CD, remove
all versions of SMART Board software or SMART Notebook software installed
on your computer, and then restart it. If you don’t know how to remove
software, ask your system administrator.

« Don’t remove the Gallery if you want to keep your existing Gallery content.

To fully install SMART Notebook, you must obtain a product key to activate your
software. Complete the following steps to obtain a product key.

In your computer’s Web browser, browse to
http://smarttech.com/nb10productkey/.

Type your SMART Board V280 interactive whiteboard’s serial number,
choose your organization type, and then press Continue.

[ NOTE
To determine your interactive whiteboard’s serial number, see page 61.

Complete the customer information form.

SMART e-mails you a product key.

NOTE

If you have more than one SMART hardware product, you don’t need to complete
this procedure for each of your products. Activate each copy of SMART Notebook
in your organization with the same product key.


http://smarttech.com/nb10productkey/
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Complete the following steps to install SMART Notebook.

To install 1. Insert the included SMART Notebook CD in your computer’s CD drive.
SMART Notebook The SMART Notebook window opens.
2. Press Install SMART Notebook, and then follow the on-screen instructions.
3. During the installation, type the product key that you received from SMART.

4. When the installation is complete, press Exit.

[ NOTE
If you didn’t type the product key during the installation, complete the following
steps to activate SMART Notebook after you install it. You must activate SMART
Notebook before you can use it.

To activate 1. Press the SMART Board icon (-] in the Windows notification area, and then
SMART Notebook select Welcome to Notebook.

2. Press the Help/Support tab.
3. Press Activate Software.
The SMART Software Activation window appears.

4. Follow the on-screen instructions.
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Clicking, Writing, Erasing and More
with the Floating Tools Toolbar

When working on your interactive whiteboard, the Floating Tools toolbar floats
over your desktop and any open application. Using a pen, select a tool from this
customizable toolbar to click, write, erase and open SMART Notebook on your
interactive whiteboard.

To open the default Floating Tools Toolbar, press the SMART Board icon [-]
in the Windows notification area, and then press Show Floating Tools.

[
Left-Click (Select) ——
Pen—— . *
Highlighter —— *
>
Eraser ——
Line ——
/ [y
Shape —+ j 441 Hide/Reveal the Toolbar
~ | 1——Move the Toolbar
Right-Click —+ & [~

SMART Keyboard — ]

SMART Notebook Software ——

Undo ——L’()

More... (Customize the Toolbar) —

[ NOTES
* You can move the Floating Tools toolbar lower down on your screen so that
younger students can reach it.

* You're unable to rotate this toolbar horizontally.



33 | GETTING STARTED WITH SMART NOTEBOOK SOFTWARE

Clicking (Mouse Mode)

When you first install SMART product drivers, SMART Notebook defaults to left-click
(or mouse) mode, which is represented by the Left-Click button on the Floating Tools
toolbar. When you press this button with a pen, SMART Notebook interprets your pen
presses on your interactive whiteboard screen as left mouse clicks and movements.

Press or double-press application icons on your interactive whiteboard’s screen
to select and open files. Press the Right-Click button on the toolbar to make your
next pen press on your interactive whiteboard screen a right-click.

Writing

Press the Pen button on the Floating Tools toolbar, and then write on the screen with
a pen to begin writing in digital ink. When you press the Pen button or any other
writing or drawing tool, a border appears around your desktop and a menu becomes
available in the upper right-hand corner. This border indicates that the Ink Layer is in
place and that you can now write on your desktop in the same way that you would
write on a transparent sheet.

[ NOTE
If the Ink Layer doesn’t appear when you select a writing or drawing tool,
you might be working in an Ink Aware application, such as Microsoft® Word,
Excel® or PowerPoint® software. See page 40 for more information about
Ink Aware applications.

For best results, hold the pen perpendicular to the writing surface so that your palm
doesn’t block the view of the cameras. If you hold the pen at an angle, your writing
might be erratic. While you write, maintain constant pressure on the writing surface
with the pen. Lift the pen off the screen between strokes so that you don’t create extra
lines. As you write, stand to the side of your interactive whiteboard so that your
shadow doesn’t block your audience’s view of the screen.

To close the Ink Layer and remove any notes or drawings, press the red x in the Ink
Layer menu. To restore your notes or drawings, press the Click here to restore ink
icon in the lower right corner of the screen.
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Erasing

To erase your pen strokes, press the Eraser button, and then move the pen over the
marks that you want to remove from your interactive whiteboard’s display. If you draw
a circle around your notes with the Eraser tool selected and then press the screen
once in the center of the circle, your notes inside the circle disappear.

To select an eraser area size, press the Eraser button on the Floating Tools toolbar,

and then press your preferred size.
pr—
X

~
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Using the On-Screen Keyboard to Add Text

To open an on-screen keyboard, press the SMART Keyboard button. With this
keyboard, you can add text to an application or dialog box without leaving your
interactive whiteboard to use your computer keyboard.

To select a keyboard style, press the Keyboard arrow. The default style is the Classic
keyboard, which looks like a regular computer keyboard. To open the Preview Pane
so that you can type an entire word or sentence before sending any information

to an application, press the Arrow button in the upper-right corner. When you finish
typing, press Send.
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Customizing the Floating Tools Toolbar

To choose from a variety of toolbar buttons, press the Customize button on the
Floating Tools toolbar. Add or remove items by dragging them to or from the toolbar.
Add or remove as many buttons as you like to fully customize Floating Tools with the
buttons you need. To recreate one of the default tool sets, press Restore Defaults.

Some of the additional buttons are shown below:

— Creative Pen

—— Shape Pen

—+—— Magic Pen

? X AN N

—+——— Welcome Center

Jn
L

— Instant Conferencing

%r.

~+—— Magnifi
\ agnifier
@ ——— Calculator
5 . Spotlight
—— Pointer

‘——— Screen Shade

Y5 - Recorder

S

| @ Screen Capture Toolbar
| —— Print Screen

-vi- - Area Capture

__"_-J - Full Screen Capture

|41 ——— Freehand Capture




To capture a region of
your desktop

36 | GETTING STARTED WITH SMART NOTEBOOK SOFTWARE

Capturing Your Notes and Creating
Presentations with SMART Notebook

Create engaging and interactive lesson activities and presentations with colorful clip
art, Adobe® Flash® objects, graphics or text using SMART Notebook.

Capturing Your Notes and Drawings
When you're finished writing, capture your

notes to a SMART Notebook page by selecting \ (i J'

the camera icon in the Ink Layer menu.
The new SMART Notebook page opens

automatically. To view your captured image, %
select the unsaved SMART Notebook “O el

(.notebook) file from the taskbar.

Select File > Save to save your notes The Digital Ink Layer
for future reference.
[ NOTE
You can change your Digital Ink Layer preferences by right-clicking the Ink Layer
and selecting Ink Layer Setting.

To display several options for capturing your notes and drawings to a
SMART Notebook page, press the Screen Capture Toolbar in Floating Tools.
To specify that you want the screen capture to appear on a new page, select
Capture to new page.

£ Capt.o [ |

IJ-"J Freehand Capture

Area Capture (Rectangle)

Full Screen Capture
Capture to new page P

Window Capture

1. Press the Area Capture button.
The Area Capture tool appears.

2. Press on any corner of the area that you wish to capture, and then drag the
selection box with the pen until it surrounds the entire area.

3. Lift the pen from the screen.

The Area Capture tool captures your selection as a graphic in a new
SMART Notebook page, which opens automatically.

4. Select File > Save to save your file.
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Creating, Managing and Presenting SMART Notebook Files
If a SMART Notebook page isn’t already open, press the SMART Notebook button

on the Floating Tools toolbar to open it, or press the SMART Board icon [-] in the
Windows notification area, and then select Notebook.

SMART Notebook software enables you to write notes and draw, and to import
graphics, text, clip art and entire files from any other application into a
SMART Notebook file.

The toolbar at the top of the page provides access to all the buttons that you need
to help you work with your SMART Notebook files, and includes many of the same
buttons as the Floating Tools toolbar.

Go to the Undo the Open the Screen Draw a Recognized
Previous Page Last Action Capture Toolbar Shape
Go to the Redo the Open the Select a Pen Select the Magic
Next Page Last Action Document or Highlighter Pen Tool
Camera
Add a Delete the Select a Select an
New Page Selected Object Creative Pen Object’s Line
[ and Fill Color
QBAIRYEX ITRED E WM/ LY PR AR
Open a SMART Show/Hide the Open a Erase an Add Text to
Notebook File Screen Shade Table Object Your File
Save Present in Full Draw a Line Select an Object’s
Your File Screen Mode Select Tool Line Properties
Paste Content Create a Shape Move the Toolbar to the
Into Your File Bottom of the Screen
Side Tabs

A SMART Notebook page includes the following side tabs:

Page Sorter D — View a thumbnail image of each page in your SMART
Notebook file.

+ Gallery E| — Add custom pages, clip art, animations and video from the Gallery
collections to your file.

+ Attachments ﬁ — Add hyperlinks or attachments from other software
applications to your file.

HA
* Properties == — Add fill effects, color and page recording to your file.
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Maximizing the Screen’s Viewing Area

To maximize the screen’s viewing area, press the Full Screen Toolbar button E
in the toolbar at the top of your SMART Notebook page. The menus, tabs and title bar
disappear. Use the Full Screen toolbar to move through your presentation, access
menu options and return to Normal view.

Indicates Which
SMART Notebook Access Tool Buttons,
Page You’re Including Blank Page,
I Vv amn E Loy

Currently Viewing Undo, Select and
Magic Pen Tool

Move Forward | | ‘ ‘

or Backward Access Menu Items, Return to
through Pages Including Pen, Eraser, Normal View
Screen Shade and
Insert Blank Page

Converting Your Handwriting to Text

To write with a pen on a SMART Notebook page, press the Pen button, and then
select a pen style. To convert a handwritten word to text, press the Left-Click (Select)
button, select your word, and then choose its correct spelling from the word object’s
drop-down menu in the upper right-hand corner.

[ NOTE

This menu also offers you other options to modify objects, including locking,
grouping, flipping or cloning them. You can also change the object’s properties.
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To access tools to record and play videos, share voice, video and data over the
Internet, and enhance your interactive whiteboard presentations, press the

SMART Board icon [-] in the Windows notification area, and then select one of the
options outlined below.

Recorder

Recorder enables you to make a video file of everything that you do on your
interactive whiteboard. Connect a microphone to record a narration of your actions,
and then play the recording on any computer with SMART Notebook Video Player
or Windows Media® Player installed.

Video Player

Video Player enables you to write or draw over a frame of video and capture your
notes to a SMART Notebook file. Use this application to play video files stored on your
computer or to view content from a camera, VCR, CD or DVD. SMART Video Player
is compatible with most video and document cameras.

Instant Conferencing Using SMART Bridgit™ Software
SMART Bridgit software enables you to share applications and information on your
desktop with anyone, anywhere in the world. Send a simple e-mail invitation to
meeting participants and easily alternate control of the desktop with them.

Other SMART Tools

Screen Shade
Gradually reveal information to your audience or class with the Screen Shade tool.

Spotlight
Help focus your audience’s attention on a specific part of your screen with the
Spotlight tool.

Magnifier

Use the Magnifier tool to select and magnify an area of your interactive whiteboard’s
screen, for example a spreadsheet cell or an Internet address, so that even people
at the back of the room can see what you’re doing.
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When software is Ink Aware, you can write and draw directly into an active software
file and your notes will be visible the next time that you open the file. If the Digital Ink
Layer doesn’t appear when you select a writing or drawing tool from the Floating Tools
toolbar, you may be working in an Ink Aware application.

Ink Aware software applications include:

Microsoft Office Microsoft Word, Excel and PowerPoint software

CoreIDRAW®, Microsoft Imaging, Corel® Grafigo™ 2,

Graphic Applications Microsoft Paint

PowerPoint, Corel Presentations™, Microsoft Office

Presentation Applications Live Meeting, Microsoft NetMeeting 3

AutoCAD®, VoloView Express™, AutoVue™
Professional, Microsoft Windows Journal, Microsoft
Office OneNote®, Microsoft Visio®, Adobe Acrobat®
Professional 6.0

Other Applications

In an Ink Aware application, similar options to the Ink Layer menu appear in the
application’s own toolbar or as a floating toolbar.

Insert Your Handwriting Capture to
as Text SMART Notebook

a X

— Modify Ink Aware
| @ | Settlngs...][i Settings

SMART Aware Toolbar

Insert Your Drawings
—
as an Image
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The SMART Notebook Help Center contains links to a wide range of information,
including procedures, concepts, help with applications, tool descriptions,
troubleshooting hints, and more. Access the Help Center from the SMART Board

icon [-] in the Windows notification area.

For more resources, visit http://www?2.smarttech.com/st/en-US/Country/, and then
select your country. In the Support section of this site, you'll find up-to-date,
product-specific information, including setup instructions and specifications.

This website’s Training Center also has free learning resources, hands-on lessons
and information on how to get more training.



http://smarttech.com/trainingcenter/
http://www2.smarttech.com/st/en-US/Country/
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Chapter 5

Maintenance and
Troubleshooting

In This Chapter

Refer to these topics for information about maintaining and troubleshooting your
SMART Board V280 interactive whiteboard.

Tips for Trouble-Free Performance ... 44
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Tips for Trouble-Free Performance

»  Ensure that you connect your SMART Board V280 interactive whiteboard
to a high-speed USB 2.0 computer interface that’s recognized by the operating
system and isn’t being used by another application.

« Make sure that you regularly install a fresh battery in each pen. Rechargeable
batteries are acceptable. When less than one hour of battery life remains, the
pen’s LED light turns red. With normal use, expect each battery to last
approximately seven weeks. You received two new batteries with your SMART
Board V280 interactive whiteboard.

* Replace the pen tip (cone) and nib when they wear out. If a pen nib is worn down
too far, you might not be able to activate the tip switch inside the pen as you write,
and the pen’s LED indicator won't illuminate. With normal use, expect each tip
and nib to last approximately 25 weeks. Use needle nose pliers to pull the tip and
nib out of the pen, and then insert new ones. You received four replacement pen
tips and nibs with your interactive whiteboard.

Nib
Tip (Cone)
New Pen Tip and Nib Worn Pen Tip and Nib
Safety Tips for Teachers

Tell students not to look directly at the light beam from the projector. Instead,
encourage them to keep their backs to the projector when working at the
interactive whiteboard. Before students turn to face the class, they should step
sideways, out of the projector’s beam.

» Make sure that you don’t look directly into the projector’s light beam. Keep your
back to the class when you write over a projected image. Step to the side of your
interactive whiteboard before you turn to face the class.

» Tell your students not to touch the projector because it can become extremely hot
during normal operation.

» Don’t use a chair to increase a student’s reach. If your students are unable to
reach the top of a wall-mounted interactive whiteboard, you might need to
remount it at a lower position.
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Preventing Damage to Your SMART Board V280 Interactive
Whiteboard’s Writing Surface

[y CAUTIONS
*  Your SMART Board V280 interactive whiteboard is not a dry-erase product.
Do not use dry-erase or permanent markers on its surface.

* Do not use harsh chemicals or abrasive cleaners on your interactive
whiteboard.
Your SMART Board interactive whiteboard is durable. However, take care to prevent
damage to the screen and other parts of your product.
+ Don’t touch the screen with sharp or pointed objects.
« Don’t leave adhesive tape on the writing surface for extended periods of time.

+ Don’t set up and use your interactive whiteboard in an area with excessive levels
of dust, humidity or smoke.

IMPORTANT
+ Before you clean your interactive whiteboard, shut down or disconnect
the connected computer.

+ To view dirt or streaks more easily, set your projector to standby (lamp off)
mode.

With proper care, your SMART Board interactive whiteboard will provide years
of trouble-free service. Follow these tips to keep your interactive whiteboard clean.

» To clean dust, dirt and finger grease, wipe the writing surface with a damp cloth
or sponge. Use mild soap, if required.

» Ifink is accidentally used on your interactive whiteboard, remove the ink as soon
as possible. Ink becomes more difficult to remove the longer it stays on the
display surface.

»  Cover ink stains with Sanford Expo® Whiteboard Cleaner (not low-odor
whiteboard cleaner), and then rub the surface clean with paper towels.


http://www.sanfordcorp.com/sanford/consumer/jhtml/new-product/productdetail.jhtml?attributeId=SNATT20042&nrProductId=SN81800

46

| MAINTENANCE AND TROUBLESHOOTING

B Te

When removing ink, don’t use Sanford Expo Dry Erase Board Doctor, Sanford
Expo Cleaning Wipes, low-odor Sanford Expo Whiteboard Cleaner

or Windex® glass cleaner, which don’t adequately clean the surface

of your SMART Board V280 interactive whiteboard and can leave
permanent stains.

If ink remains on your interactive whiteboard for a long period of time, you might
need to scrub the ink with Sanford Expo Whiteboard Cleaner for as long as five
minutes. Although a faint residue might remain, it isn’t usually visible when the
projector is on.

Remove persistent stains by gently rubbing a paste of baking soda and water
on the screen surface.

The digital cameras located in each screen corner under the valance
are protected from dust and dirt by protective windows. You only need
to clean the camera windows if your interactive whiteboard is located
in an extremely dusty environment.

Rotate the valance upwards in its clips to clean the diagonal surfaces of the
camera windows. Gently rub a soft, clean, damp, cotton cloth or cotton-tipped
swab on the windows.

A CAUTION
Do not use an abrasive cloth or paper towel to clean the camera windows
because you might scratch the surface.
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Adjusting the Projected Image

If your projector isn’t installed in a fixed location, you can correct many image
problems by shifting your projector so that the projected image fits squarely on your
interactive whiteboard’s screen. Optimally, each side of the image should extend
almost to the edge of your interactive whiteboard’s display surface. You can then
adjust the zoom lens to display a focused image.

[ NOTES
« Don’t adjust the image size and geometry based upon your projector’s splash
screen. The splash screen image is much smaller than the computer’s
projected image. Before you adjust the projected image, make sure that you
set the computer’s resolution and refresh rate (see page 24).

+  Complete the following procedures only as required.

« If you're unable to adjust the projected image to fill the entire writing surface
and you're experiencing difficulty orienting your interactive whiteboard, see
The orientation procedure stops at the first point and won’t proceed to the
next point on page 52.

To adjust the 1. If the left and right edges of the projected image aren’t parallel, raise or lower your
projected image projector at the front or back until the edges are parallel.

2. Ifthe top and bottom edges aren’t parallel, turn the projector slowly until the edges
are parallel.

3. Further adjust your projector using small, slow movements until you're satisfied
with the projected image.

— Correct the image’s horizontal and vertical position by adjusting the height
and position of the projector platform or stand.

— Adjust the image laterally by sliding the projector to the left or right.

— Adjust the image size by moving the projector forward or backward
to increase or reduce the image size until it correctly fills the screen.

4. Make fine adjustments to the image level and size according to your projector
manufacturer’s instructions.

[ NOTE
The method for changing the projected image depends on your projector.
For more information, see the instructions included with your projector.

5. Create a clear image by adjusting your projector’s focus function.
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Resetting Your Interactive Whiteboard

If your interactive whiteboard behaves erratically or becomes unresponsive, possibly
because of an electrostatic discharge, a power interruption or some other event, you
might be able to restore normal operation by resetting your interactive whiteboard.

You can reset your interactive whiteboard by disconnecting and then reconnecting
the USB cable. This turns the power off and back on, restarting all components of your
interactive whiteboard. All data (including orientation data) stored on the cameras
will be retained.

Troubleshooting Tips
This section describes the symptoms, causes and solutions for problems that you
might experience with your SMART Board V280 interactive whiteboard.

Try the troubleshooting tips in the following table to quickly resolve most issues
with your product.

Symptoms Cause Solution

Your computer slows  Your computer doesn’t  Ensure that your computer meets
down or stops meet the minimum or exceeds the minimum system
responding when you system requirements requirements for your interactive
connect it to your for your interactive whiteboard.

interactive whiteboard.

For your interactive whiteboard’s
system requirements,

see document 121618

at www.smarttech.com/support.

whiteboard.

There are too many Disconnect any external peripheral
external peripheral devices that you're not using.
devices connected

to your computer,

increasing demand

on its CPU.



http://www2.smarttech.com/kbdoc/121618
http://www2.smarttech.com/st/en-us/support
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Symptoms

Cause

Solution

There is no image
projected on your
interactive
whiteboard’s screen,
or a “No Input”
message appears.

Your projector isn’t
receiving a video signal.

« Check the video cable
connections.

» Check that the correct video
input is selected on your
projector.

« Ensure that your projector
is on, and that it's connected
to a power source.

 If you're using a laptop
computer, switch the external
video connection on.
Refer to your laptop’s user guide
for more information.

Your computer is
in standby mode.

Move the mouse or touch any key
on your keyboard to bring your
computer out of standby mode.

Your computer is off.

Turn on your computer (or press
your computer’s reset button), and
then log on as usual.

The projected image
is blurry, too large or
doesn’'t completely fill
your interactive
whiteboard’s screen.

Your projector’s
position, zoom and
focus settings aren’t
adjusted.

Adjust the projector’s position,
zoom and focus settings.

Refer to your projector’s manual
for more information.

Your computer’s video
resolution settings don’t
match your projector’s
native resolution.

Consult your projector’s manual
for the correct computer video
resolution, and then select Start >
Control Panel > Display and
change the video resolution

to match your projector.

[ NOTE

This procedure might vary,
depending on your version
of Windows operating system
and your system preferences.
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Symptoms Cause

Solution

You see a message  Your computer isn’t
telling you that your  high-speed USB 2.0

interactive whiteboard compliant.
requires a high-speed

USB 2.0 compliant

computer.

Replace your computer with a
newer, high-speed, USB 2.0
compliant model.

For your interactive whiteboard’s
system requirements,

see document 121618

at www.smarttech.com/support.

[ NOTE

This procedure might vary,
depending on your version
of Windows operating system
and your system preferences.

To check if your computer is
high-speed, USB 2.0 compliant:

1. Select Start > Control Panel.

The Control Panel window
opens.

2. Double-click System.

The System Properties window
opens.

3. Select the Hardware tab, and
then select Device Manager.

The Device Manager window
opens.

4. Expand Universal Serial Bus
controllers.

If you see a listed controller
with the word “Enhanced”

in its name, for example,
Intel® ICH8 Family USB2
Enhanced Host Controller,
your computer is high-speed
USB 2.0 compliant.



http://www2.smarttech.com/kbdoc/121618
http://www2.smarttech.com/st/en-us/support
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Symptoms

Cause

Solution

You see a message
telling you that your
interactive whiteboard
requires a high-speed
USB 2.0 compliant
computer.

(continued)

The included USB
cable isn’t connected
to a high-speed USB
2.0 compliant port

on your computer.

On some computers,
the front USB ports
aren’t high-speed USB
2.0 compliant.

Try a different USB port.

You see a message
telling you that a
connected device
could operate faster.
If you click this
message, another
message instructs
you to connect your
interactive whiteboard
toaUSB 2.0
compliant port.

There are too many
devices connected to
your computer.

As a result, your
operating system must
use a non-enhanced
controller to connect
your interactive
whiteboard.

Disconnect the additional USB
devices to ensure that your
interactive whiteboard connects
to an enhanced host controller.

IMPORTANT

Your SMART Board V280
interactive whiteboard does not
support webcams connected
to your computer. Either your
interactive whiteboard or the
webcam will not function
reliably.

The included USB
cable isn’t connected
to a high-speed USB
2.0 compliant port

on your computer.

On some computers,
the front USB ports
aren’t high-speed USB
2.0 compliant.

Try a different USB port.

The SMART Board

icon [-] doesn’t
appear in the
Windows notification
area.

SMART Board Tools
aren’t running.

Start SMART Board Tools.
To start SMART Board Tools:

Select Start > All Programs >
SMART Technologies >
SMART product drivers >
SMART Board Tools.

SMART product drivers
aren’t installed.

Install SMART product drivers
on your computer.

For details about installing SMART
product drivers, see page 25.



http://www2.smarttech.com/kbdoc/122239
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Symptoms

Cause

Solution

The orientation
procedure stops
at the first point
and won'’t proceed
to the next point.

The projected image
doesn’t completely fill
the writing surface

of your interactive
whiteboard.

SMART product drivers
orientation software is
optimized for the field
of view of each camera
when the projected
image fills the entire
writing surface. If your
projected image is too
small, the field of view
of the cameras won'’t
include the first
orientation point.
Therefore, the software
won’t detect your touch
point, and the
orientation

procedure stalls.

Move your projector away from
your interactive whiteboard or
adjust the projector’s zoom feature
so that the projected image fills the
entire writing surface, and then
repeat the orientation procedure.

OR

If you can’t adjust the projected

image to fill the entire writing

surface of your interactive

whiteboard, perform the following

steps:

1. In the Windows notification
area, select the SMART Board

icon [-], and then select
Control Panel.

The SMART Notebook control
panel opens.

2. Select SMART Hardware
Settings.

3. From the drop-down menu,
select Orientation/Alignment
Settings.

4. Clear the Projected image
fills the entire display area
option.

5. Click Apply.

6. Click Orient/Align the SMART
Product.

The orientation screen
appears.

7. Perform the orientation
procedure.
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Symptoms

Cause

Solution

Your interactive
whiteboard's screen
doesn't respond when
you touch it with a
pen, the pointer
moves erratically or
gaps appear when
you draw or write, or
the pen doesn’t work
reliably near the
bottom of the screen.

Your interactive
whiteboard isn’t
oriented properly.

Orient your interactive whiteboard.

For more information about
orienting your interactive
whiteboard, see page 26.

Extra light in the room is
affecting your
interactive whiteboard’s
performance.

Close any blinds and shades, or
turn off all halogen and LED lights.

SMART Board Tools
aren’t running.

Start SMART Board Tools.

Select Start > SMART
Technologies > SMART Board
drivers > SMART Board Tools.

SMART product drivers
aren’t installed.

Install SMART product drivers
on your computer.

For details about installing SMART
product drivers, see page 25.

Your interactive
whiteboard’s screen
surface is curved,
obstructing the line

of sight from your
interactive whiteboard’s
digital cameras to the
tip of the pen.

Ensure that you secured your
interactive whiteboard to the wall
to hold it flat.

For more information, see page 15.

For more information about
checking for surface curvature,
see document 135276

at www.smarttech.com/support.

Your computer is
running too many
applications.

Close some open applications.

The USB power from
your laptop, computer
or USB extender is too
low to power your
interactive whiteboard.

Connect your laptop or computer
to an AC power receptacle.

OR

Eliminate or substitute the USB
extender.

OR
Install a powered USB hub.

Your computer doesn’t
meet minimum
specifications.

Upgrade your computer or replace
it with a more powerful one.

For your interactive whiteboard’s
system requirements,

see document 121618 at
www.smarttech.com/support.



http://www2.smarttech.com/kbdoc/122239
http://www2.smarttech.com/kbdoc/135276
http://www2.smarttech.com/st/en-us/support
http://www2.smarttech.com/kbdoc/121618
http://www2.smarttech.com/st/en-us/support
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Symptoms

Cause

Solution

Pen strokes or parts
of letters are missing
when you write
quickly on your
interactive
whiteboard.

[ NOTE
This issue doesn't
occur when you
use handwriting.

Your interactive
whiteboard’s frame rate

might be set too low.

Increase your interactive
whiteboard’s frame rate.

To determine whether your
interactive whiteboard’s frame rate
is set too low, write the same word
twice: once slowly, and once
quickly. If your strokes are
complete in the slow version but
not in the quick version, the frame
rate is set too low.

To increase your interactive
whiteboard’s frame rate:

1. In the Windows notification
area, selectthe SMART Board

icon [-], and then select
Control Panel.

The SMART Notebook control
panel opens.

2. Select About Software and
Product Support > Tools >
Diagnostics.

The SMART Board
Diagnostics window opens.

3. Select View > V200 Bar,
and then select Frame Rate.

The Frame Rate window
opens.

4. Move the slider to 60, and then
select OK.

The Frame Rate window and
the V200 bar close
automatically.

5. Close the SMART Board
Diagnostics window, and then
close the SMART Notebook
control panel.
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Symptoms Cause

Solution

Unwanted connection The Double-click Zone
lines appear between might be too large for
printed letters when  your style of printing.

you write quickly Your interactive

on your interactive whiteboard is

whiteboard. incorrectly reading your
printing strokes as
double-clicks.

Decrease the size of the
Double-click Zone.

To decrease the size of the
Double-click zone:

1.

In the Windows notification
area, select the SMART Board

icon [-], and then select
Control Panel.

The SMART Notebook control
panel opens.

Select SMART Hardware
Settings.

From the drop-down menu,
select Mouse Settings.

In the Double-click Zone, move
the slider to the second square
from the right.

Select Apply, and then select
OK.

NOTE

If the lines still drag, decrease
the size of the double-click
zone again. Repeat steps 1
to 3, and then move the slider
farther to the right.
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Symptoms

Cause

Solution

There is a small red x
on the SMART Board

icon [4.

SMART Notebook
software is unable to
detect your interactive
whiteboard.

Check that the cable extending
from each camera to the USB hub
behind your interactive whiteboard
is securely connected, and that the
USB 2.0 cable is connected to both
the USB hub (on the back of your
interactive whiteboard) and your
computer.

The included USB
cable isn’t connected
to a high-speed USB
2.0 compliant port on
your computer.

On some computers,
the front USB ports
aren’t high-speed
USB 2.0 compliant.

Try a different USB port.

SMART Board Service
isn’t running.

Start SMART Board service.

To start SMART Board service:

1. In the Windows notification
area, select the SMART Board
icon [, and then select
Control Panel.

The SMART Notebook control
panel opens.

2. Select About Software and
Product Support > Tools >
Diagnostics.

The SMART Board
Diagnostics window opens.

3. Select the Service menu, and
then select Start.

4. Close the SMART Board
Diagnostics window, and then
close the SMART Notebook
control panel.

There are too many
high-speed USB
devices connected to
your computer.

Disconnect any webcams or other
high-speed USB devices.
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Symptoms Cause

Solution

There is a small red x The USB CCID Smart
on the SMART Board Card driver installed on
icon [4. your computer failed

to access the Atmel®
chip on your interactive
whiteboard’s USB hub.

(continued)

n NOTE
The USB CCID
Smart Card driver
encrypts data from
each of your
interactive
whiteboard’s
cameras, which
connect to the
USB hub.

Check the SMART Board service
log to see if there is an error
indicating that the USB CCID
Smart Card driver failed to access
the Atmel chip. If there is an error,
disconnect and reconnect the
USB cable.

To check the SMART Board
service log:

1.

In the Windows notification
area, select the SMART Board
icon [d, and then select
Control Panel.

The SMART Notebook control
panel opens.

Select About Software and
Product Support > Tools >
Diagnostics.

The SMART Board
Diagnostics window opens.

Check the SMART Board
service log file. If you see the
following error, the USB CCID
Smart Card driver failed to
access the Atmel chip:

22: (4/22 10:13:23.114)
- Error: The data
necessary to complete
this operation is not
yet available.
(0x8000000a) . sBV280
init failed due to
Smart Card not
connected. Unplug and
replug of usb cable
might fix the error.

Close the SMART Board
Diagnostics window, and then
close the SMART Notebook
control panel.
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Symptoms Cause

Solution

There is a small red x The camera calibration
on the SMART Board data is lost.

icon [4.

(continued)

Restore the back-up camera data
from the registry.

To restore the back-up camera
data:

1.

In the Windows notification
area, select the SMART
Board icon [, and then select
Control Panel.

The SMART Notebook control
panel opens.

Select About Software and
Product Support > Tools >
Diagnostics.

The SMART Board
Diagnostics window opens.

Select Default (or Restore
Camera Defaults) to restore
the camera data.

Close the SMART Board
Diagnostics window, and then
close the SMART Notebook
control panel.

NOTE

The Connection Wizard
enables the Restore Camera
Defaults button if both
cameras are detected but
your interactive whiteboard
isn’t detected.
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Symptoms

Cause

Solution

There is a small red x
on the SMART Board

icon [4.

(continued)

Stop and then start SMART Board
service.

To stop SMART Board service:

1.

In the Windows notification
area, select the SMART Board

icon [d, and then select
Control Panel.

The SMART Notebook control
panel opens.

Select About Software and
Product Support > Tools >
Diagnostics.

The SMART Board
Diagnostics window opens.

Select the Service menu,
and then select Stop.

Close the SMART Board
Diagnostics window, and then
close the SMART Notebook
control panel.

To start SMART Board service:

1.
2.

Repeat steps 1 and 2, above.

Select the Service menu,
and then select Start.

Close the SMART Board
Diagnostics window, and then
close the SMART Notebook
control panel.

Restart your computer.
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Symptoms Cause Solution
The pen’s LED status The pen’s battery Replace the old battery with a new
lightdoesn'tilluminate is weak or dead. or recharged one.

green when you press
the tip switch on the
nib with your finger
or against your

For more information about
checking your pen’s battery
charge, see document 129600
at www.smarttech.com/support.

interactive

whiteboard. The The pen nib is worn Replace the pen nib and tip (cone).
screen also doesn't  down. It isn’t long You received four replacement pen
respond when you enough to press the nibs and tips with your interactive
touch it with a pen,  switch inside the pen.  whiteboard.

and you're unable to

write in digital ink. For more information about

checking and replacing your pen’s
nib, see document 129600
at www.smarttech.com/support.

The battery orientation Remove the battery, and then
is backward. insert it as illustrated inside the
battery compartment.

Save your original SMART Board interactive whiteboard packaging so that it's
available if you need to transport your interactive whiteboard. When required, repack
your interactive whiteboard with as much of the original packaging as possible.

This packaging was designed with optimal shock and vibration protection. If your
original packaging is no longer available, you can purchase the same packaging
directly from your authorized SMART reseller.



http://www2.smarttech.com/kbdoc/129600
http://www2.smarttech.com/st/en-us/support
http://www2.smarttech.com/kbdoc/129600
http://www2.smarttech.com/st/en-us/support
http://www2.smarttech.com/st/en-US/Where+to+Buy/

To determine your
interactive whiteboard’s
serial number
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SMART Technical Support welcomes your call. However, if you experience difficulty
with your SMART product, you might want to contact your authorized SMART reseller
first. Your local reseller might be able to resolve the issue without delay.

Before contacting SMART Technical Support, make note of your SMART Board V280
interactive whiteboard’s serial number, and then note it in the inside cover of this
manual (if you printed it).

The serial number is located on the lower right edge of your interactive whiteboard’s
frame if you are facing the front of your interactive whiteboard, and also under its
pen tray.

The serial number matches your interactive whiteboard’s model number and has
the following format: SBV280-xxxxxx.

I w

Serial Number
I Location
B B 5]



http://www2.smarttech.com/st/en-US/Where+to+Buy/
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Appendix A
Specification
Drawings

Wall-Mounted Cut Away View

Leave at least 5/8" (1.6 cm) headroom to wall-mount your interactive whiteboard.

&
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53/8" (13.7 cm)

Wall-Mounted Side View
—>{¥<—3" (7.7 cm)

B2l

—Pl |—4" (10.1 cm)
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All dimensions +/- 1/8" (3.2 mm)



Appendix B

Extending Your USB
2.0 Cable

The 16' (5 m) high-speed USB 2.0 cable included with your SMART Board V280
interactive whiteboard is within the limit defined by the USB 2.0 standard for
maximum length.

However, if this cable isn’t long enough to reach
from your computer to your interactive
whiteboard, you can use a bus powered hub
such as the SMART Active USB Extension Cable
(Part No. USB-XT) to extend your USB
connection by 16' (5 m). This configuration
provides a total 32' (10 m) reach between your
interactive whiteboard and your computer.

See the diagram on the following page.

SMART Active USB Extension Cable
(SMART Part No. USB-XT)

IMPORTANT

»  Connect an external power supply (not included) to your SMART Board V280
interactive whiteboard when using a bus powered hub, such as the SMART
Active USB Extension Cable, with your product. This power supply ensures
that your interactive whiteboard receives enough power to function reliably.

+ Passive USB extension cables are not supported. (An active device includes
circuitry for regenerating the USB signals.)

* The external power supply (when required) must meet the Limited Power
Source (LPS) requirements of CSA/UL/IEC/EN 60950-1.
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This external power supply should meet the following specifications.

Specification

Parameter

Power Supply

+ 5.0 V DC with 5% or better regulation
* 1.5 A of current (typical draw - 500 mA)

Connector

1/4" x 1/8" (5.5 x 2.1 mm), center positive
coaxial connector

International Support

120-240 VAC Input

Certifications and Compliance

Limited Power Source (LPS) requirements
of CSA/UL/IEC/EN 60950-1

16' (5 m)

A power supply connects
to the receptacle on the
bottom of the USB hub
at the back of your
interactive whiteboard.

The 16' (5 m) passive
SMART USB 2.0 cable
(included) connects to your
SMART Board V280
interactive whiteboard.

A 16' (5 m) SMART Active
USB Extension Cable
(Part No. USB-XT)
connects the USB 2.0
cable and your computer.

Extending the USB Connection Between Your Interactive Whiteboard and Your Computer
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Mounting Your
Interactive

Whiteboard
on a Floor Stand

Before Mounting Your Interactive Whiteboard on a

Floor Stand

Before mounting your SMART Board V280 interactive whiteboard on an FSV280 floor
stand, carefully read and observe the following instructions for operating safety and to
avoid damage to your product.

[y WARNING
* Two people are required to safely mount your interactive whiteboard on a
floor stand because it might be too large for one person to safely maneuver
alone. When you lift your interactive whiteboard, you and your assistant
should stand on either side of the screen, supporting its weight at the bottom
corners while balancing the top with your other hands.

» Do not leave cables on the floor where they can be a tripping hazard. If you
must run a cable over the floor, lay it in a flat, straight line and secure it to the
floor with tape or a cable management strip of a contrasting color. Handle
cables carefully and avoid excessive bending.

* Do not mount your SMART Board V280 interactive whiteboard on an FS670
or FS570 floor stand. These floor stands do not provide the correct locking
mechanisms to properly secure your interactive whiteboard. Using these
stands could result in personal injury and product damage.

* Move a floor stand-mounted interactive whiteboard with care. Quick stops,
excessive force and uneven surfaces may cause your interactive whiteboard
to overturn.
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Contents of Your FSV280 Floor Stand Shipping Box

Your FSV280 floor stand shipping box contains:
«  Two upright braces (A)

+ Left foot (B)

* Right foot (C)

* Left upright (D)

* Right upright (E)

+  Bottom cross-bar (F)

+ Two vertical frame parts (G)

*  Bottom frame part (H)

« Top frame part (J)

*  One-year limited product warranty document
*  Multi-lingual product warnings document

» Textless installation instructions (not shown)

You also received a hardware kit containing the
following smaller parts:

+ Sixteen 1 1/2" (3.8 cm) button-head screws
with split washers (K)

»  Center interactive whiteboard support
bracket (L)

+ Five 1/2" (1.3 cm) button-head screws
with split washers (M)

* Right interactive whiteboard support
bracket (N)

» Left interactive whiteboard support
bracket (P)

*  Four carriage bolts (Q)

*  Four locking nuts (R)

» Two security brackets (S)

* 5/32" (4 mm) hex key
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Other Tools and Parts Required
To mount your SMART Board interactive whiteboard on a floor stand, you'll also need
the following tools and parts, which aren’t included with your floor stand:

* a Phillips No. 2 screwdriver

* a7/16" (11 mm) wrench

» three small thread-forming screws
(included with your SMART Board V280
interactive whiteboard)

[ NOTE
You’ll need the help of another person

7/16"

to mount your interactive whiteboard 7> 2 (11 mm)
on a floor stand. / 0

To mountyour 1. Hook the blunt end of each upright brace (A)
interactive whiteboard into the left and right feet (B and C), and then
on an FSV280 floor stand guide the opposite hooked end of each brace
(A) into the left and right uprights (D and E),
as illustrated.

2. Align each foot until it's perpendicular
to its corresponding upright, and then secure
them with two 1 1/2" (3.8 cm) button-head
screws (K). Use the included hex key to tighten
the screws.
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3. Secure the bottom cross-bar (F) to the uprights
(D and E) with two 1 1/2" (3.8 cm) button-head
screws (K). Use the included hex key to tighten
the screws.

[ NOTE
The square holes on the uprights (D and E)
must face outward.

4. Secure both the vertical frame parts (G)
to the bottom and top frame parts (H and J) with
two 1 1/2" (3.8 cm) button-head screws (K), as
illustrated. Ensure that the vertical frame parts
(G) are on the outside of the frame assembly,
and that both the angled, tabbed side of the top
frame part (J) and the center hole on the bottom
frame part (H) face outward. Use the included
hex key to tighten the screws.

5. Secure your interactive whiteboard support

bracket (L) to the center of the bottom frame
part (H) with a 1/2" (1.3 cm) button-head screw
(M), as illustrated. Use the included hex key

to tighten the screws.

6. With the help of another person, fit this frame
between the uprights of the support assembly
that you completed in step 3.
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7. Secure the frame to the upright support
assembly in four places with a carriage bolt (Q)
and a locking nut (R), as illustrated. For the two
lower locations, insert the right and left
interactive whiteboard support brackets
(N and P) between the locking nut (R) and
the right or left vertical frame part, as illustrated.
Use your 7/16" (11 mm) wrench to tighten
the locking nuts.

[ NOTES

— Do not over-tighten these nuts.

— If you secure the frame to the third hole
from the bottom on the upright support
assembly, the distance to the top
of your interactive whiteboard will be
75" (190.5 cm), which will enable you
to move your floor stand-mounted
interactive whiteboard through
an 80" (2 m) high door opening.

8. With the help of another person, hang your
SMART Board V280 interactive whiteboard
on the floor stand so that the tabs at the top
of the frame fit into the slots in the
wall-mounting bracket on the back of your
interactive whiteboard. Slide the three
interactive whiteboard support brackets on the
floor stand into the corresponding brackets
under your interactive whiteboard’s pen tray.
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9. Insert each security bracket (S) into the empty
slot above the double holes in the
wall-mounting bracket at the back of your
interactive whiteboard. Secure it with two
1/2" (1.3 cm) button-head screws (M). Use
the included hex key to tighten the screws.

10. Secure each of the three interactive whiteboard
support brackets to its corresponding pen tray
bracket with one of the small thread-forming
screws (zz) included with your SMART Board

V280 interactive whiteboard.
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Hardware
Environmental
Compliance

SMART Technologies supports global efforts to ensure that electronic equipment is
manufactured, sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment
Regulations (WEEE Directive)

Waste Electrical and Electronic Equipment regulations apply to all electrical and
electronic equipment sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART
Technologies products, we strongly encourage you to properly recycle the electronic
product when it has reached end of its life. If you require further information, please
contact your reseller or SMART Technologies for information on which recycling
agency to contact.

Restriction of Certain Hazardous
Substances (RoHS Directive)

This product meets the requirements of the European Union’s Restriction of Certain
Hazardous Substances (RoHS) Directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in
various geographical areas, and that reference the European Union’s RoHS directive.
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Batteries are regulated in many countries. Check with your reseller to find out how to
recycle used batteries.

There are special regulations that must be met when shipping a product that has a
lithium ion battery packaged with the product or shipping a lithium ion battery. When
returning a SMART Technologies product which contains a lithium ion battery or
returning a lithium ion battery, call SMART Technologies RMA for information on these
special shipping regulations:

+ 1.866.518.6791, Option 4 (U.S./Canada)
+ 1.403.228.5940 (all other countries)

Many countries have regulations restricting the use of certain heavy metals in product
packaging. The packaging used by SMART Technologies to ship products complies
with applicable packaging laws.

Many U.S. states classify monitors as Covered Electronic Devices and regulate their
disposal. Applicable SMART Technologies products meet the requirements of the
Covered Electronic Devices regulations.

China regulates products that are classified as EIP (Electronic Information Products).
SMART Technologies products fall under this classification and meet the
requirements for China’s EIP regulations.

The United States has enacted the Consumer Product Safety Improvement Act which
limits the lead (Pb) content in products used by children. SMART Technologies is
committed to complying with this initiative.
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California Air Resource Board —
Airborne Toxic Control Measure

California has enacted a law to restrict the emissions of Formaldehyde from
Composite Wood Products. The SMART Technologies products that contain
Composite Wood Products are compliant with this regulation.
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Customer Support

Online Information and Support

Visit www.smarttech.com/support to view and download user’s guides, how-to and
troubleshooting articles, software and more.

Training
Visit www.smarttech.com/trainingcenter for training materials and information about
our training services.

Technical Support

If you experience difficulty with your SMART product, please contact your local
reseller before contacting SMART Technical Support. Your local reseller can resolve
most issues without delay.

n NOTE
To locate your local reseller, visit www2.smarttech.com/st/en-US/Where+to+Buy.

All SMART products include online, telephone, fax and e-mail support:

Online www.smarttech.com/contactsupport

Telephone +1.403.228.5940 or
Toll Free 1.866.518.6791 (U.S./Canada)
(Monday to Friday, 5 a.m. — 6 p.m. Mountain Time)

Fax +1.403.806.1256

E-mail support@smarttech.com

Shipping and Repair Status

Contact SMART’s Return of Merchandise Authorization (RMA) group, Option 4,
+1.866.518.6791, for shipping damage, missing part and repair status issues.


http://www.smarttech.com/support
http://www.smarttech.com/trainingcenter
http://www2.smarttech.com/st/en-US/Where+to+Buy/
http://www.smarttech.com/contactsupport
mailto:support@smarttech.com
http://www.smarttech.com/contactsupport
mailto:support@smarttech.com
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General Inquiries

Address SMART Technologies
3636 Research Road NW
Calgary, AB T2L 1Y1
CANADA

Switchboard  +1.403.245.0333 or
Toll Free 1.888.42.SMART (U.S./Canada)

Fax +1.403.228.2500
E-mail info@smarttech.com
Warranty

Product warranty is governed by the terms and conditions of SMART’s “Limited
Equipment Warranty” that shipped with the SMART product at the time of purchase.

Registration

To help us serve you, register online at www.smarttech.com/reqistration.
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accessories, 7

floor stand, 7, 11

pen, 7

USB 2.0 cable, 7

USB extender cables, 7

wall-mounting kit, 7
adjusting projected image, 47
airborne toxic controls, 75
aligning your interactive whiteboard
to your projector, 15
aspect ratio, 2

batteries, 74
Bridgit conferencing software
(SMART), 39

California Air Resource Board, 75
cameras
cleaning, 46
Chinese regulations, 74
cleaning, 45
erasing ink, 45
under valance, 46
computer
connecting to interactive
whiteboard, 21

matching resolution to projector, 24, 47

recommended settings, 24
refresh rate, 24, 47
system requirements, 4

concrete installation, 72, 14, 16, 74

contact information, 78
contacting SMART
online resources, 41
technical support, 60, 61
covered electronic devices, 74
customer support, 77-78

damage, preventing, 45

Digital Vision Touch (DViT) technology, 2

documentation, 77
dust, 10, 45

EIP regulations, 74

electrostatic discharge, 70
emissions, 10

environmental compliance, See
hardware environmental compliance
environmental requirements, 10
European Union regulations, 73

flammability, 70

Floating Tools
customizing, 35

floor stand, 7, 11

general inquiries, 78
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hardware environmental online resources, 41

compliance, 73—-74 online support, 77

humidity, 70, 45 orientation, 26

precision, 27

inquiries, 78

installation packaging, 74
concrete wall, 12, 14, 16 parts, accessories, 7
connect to computer, 21 pens, 7
connect USB cable, 22 install battery, 18
location, 11 LED indicator, 18
pen battery, 18 nibs and tips, 7, 44
SMART product drivers, 25 working with, 28
tools, 12 projector

installation height adjusting image, 47
adults, 11 aligning interactive whiteboard, 15
children, 11 resolution, 24

standby mode, 24

Kensington lock, 17, 19
quality assembly, 10

Limited Equipment Warranty, 78
lithium ion batteries, 74 registration, 78
regulatory compliance, See hardware
environmental compliance
replacement parts, 7
floor stand, 7, 11
pen, 7
USB 2.0 cable, 7
USB extender cables, 7
wall-mounting kit, 7
Notebook Software, See SMART resetting your interactive whiteboard, 48
Notebook software resolution

maintenance, 43

computer, 24, 47
projector, 24
RoHS directive, 73
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safeguarding your interactive
whiteboard, 79
serial number, 61
shipping box
ordering, 60
SMART Board V280 interactive
whiteboard
clicking (mouse mode), 33
features, 2
how it works, 3
orienting, 26
resetting, 48
SMART Bridgit conferencing
software, 39

SMART Notebook software, 2, 3, 30
capturing notes and drawings, 36
converting handwriting to text, 38
customizing Floating Tools, 35

erasing digital ink, 34
Floating Tools, 32
full screen, 38
getting started, 29

importing graphics/text/files, 37

Ink Aware applications, 40
installing, 25

online resources, 41

other tools, 39
presentations, 36

side tabs, 37

writing with digital ink, 33

SMART technical support, 77
smoke, 45

specifications, 63

support, 77-78

technical support, 60, 61, 77
temperature, operating, 70
training, 77

transporting, 60
troubleshooting, 43
troubleshooting articles, 77

U.S. regulations, 74
USB

cable, 7, 22

extender cables, 7, 23

USB 2.0 interface, 2, 22, 44
user’s guides, 77

warranty, 78
water and fluid resistance, 10
WEEE directive, 73
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